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8.  TUTORIAL

8.1.  Tutorial Organization
The tutorial section of this manual is organized as follows:

8.2. Start THERM.

8.3. Draw the frame cross-section geometry using different techniques:

8.3.1.  by using THERM’s autoconvert DXF file feature,

8.3.2.  by importing and tracing an underlay file,

8.3.3.  by using a dimensioned drawing.

8.4. Import a glazing system from WINDOW 4.

8.5. Define the Boundary Conditions.

8.6. Run and View the Results.
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8.2.  Start THERM

� From the Windows 95™ or Windows NT™ Start button, Programs choice, click on THERM to
activate the program.

Figure 8-1.  Start THERM from the Start button on the Windows 95™ or Windows NT™ Taskbar.

� THERM will open with a blank drawing area and no files loaded. By default, the program will
assign a name of Untitled-1 to the first drawing. When you save the cross section, you can
change the name of the file.

Figure 8-2.  THERM starts with a blank drawing area and no files loaded.
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8.3.  Draw the Frame Cross-Section Geometry

You can use three methods to input a cross-section geometry.  Section 8.3.1 shows how to input a cross
section using the THERM underlay autoconvert feature, which automatically converts polygons from a DXF
file.  Section 8.3.2 shows how the same DXF underlay file can be used to trace the polygons.  Section 8.3.3
shows how the same profile can be input from a dimensioned drawing.

8.3.1.  Import Underlay with Autoconvert On

� From the File menu, select the Underlay menu choice.

Figure 8-3.  To import an underlay, use the File menu, Underlay choice.

� You will see the Underlay dialog box.

Figure 8-4.  The Underlay dialog box is used to import a file to use as an underlay for a THERM cross section.

� Click on the Browse button.

� You will see a standard Windows™ Open dialog box, showing all files in your current working
directory with either a BMP or DXF file extension; you can change working directories and drives if
desired.  You should see at least the following sample file that was installed with THERM:

� SAMPLE.DXF

� Highlight SAMPLE.DXF by placing your cursor over it and clicking the left mouse button.
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Figure 8-5.  Select SAMPLE.DXF as the underlay file.

� Click on the OK button, and you will return to the Underlay dialog box.

� In the Underlay dialog box, click on the Autoconvert check box so it has a check mark, and click on
the OK button.

Click on AutoConvert, so  a check
mark appears. This will cause
THERM to automatically convert the
polygons in the DXF file.

Figure 8-6.  Click the Autoconvert check box when importing the underlay file.

� If the DXF file is complex and takes a few seconds to import, a small DXF Import dialog box may
appear, showing a counter as THERM reads the DXF file.

Figure 8-7.  The DXF Import dialog box may display the underlay import status,
depending on the complexity of the DXF file and the speed of your computer.

� When THERM has finished autoconverting the underlay file, the cross section is displayed with
polygons defined for all the elements it could interpret. See Section 5.2, "Importing a DXF or
Bitmap File as an Underlay" for details about defining the DXF file so that THERM can
autoconvert the polygons properly.
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� The DXF file will have been brought into the drawing area including all the white space in the
original drawing.  THERM attempts to fill the drawing area with the autoconverted cross section
while still making the viewing scale as big as possible.  In the figure below, you can see both the
THERM origin (corresponding to the origin of the DXF file) and the cross section.

Next draw the frame that the glazing sits in using the same method above, and after that,
draw the inside stop, as shown in Figure 8-20.Next draw the frame that the glazing sits in
using the same method above, and after that, draw the inside stop, as shown in Figure 8-20.

Exterior Stop

Interior Stop

Frame

DXF file origin and
THERM origin
(crosshair)

Locator (circle)

Figure 8-8.  The components of the cross section

8.3.1.1.  Save the File

� Save your work using the Save File toolbar button or the File/Save menu choice.  Type a name
that is not already being used, such as Tutorial (a file named Sample.thm is included in the
installation, so pick a different name to avoid overwriting the sample file), and click on the OK
button.  THERM will automatically add the THM extension, so the file name will appear as
TUTORIAL.THM.

8.3.1.2.  Edit Cross Section

� If you want to zoom in, place the mouse cursor in the area of the underlay that you want to be in the
center of the zoomed view and click the right mouse button.  You only need to see the frame area of
the cross section, not the glazing area. If you zoom in too far, hold the Shift key down and click the
right mouse button to zoom back out. If you want to return to the original, centered view, hold down
the Ctrl key and click the right mouse button.

� Because of the way this DXF file was defined, only the frame components of the underlay are
converted but not the glazing system. The glazing system will be imported from WINDOW in a
separate step later in the tutorial.

8.3.1.3.  Assign Materials to Polygons

� Select the polygon representing the frame by placing the mouse cursor inside the polygon and
clicking the left mouse button once. The vertices of the selected polygon will be displayed as squares.
Select Wood (Pine, Spruce, Fir) from the Materials pull-down list on the right-hand side of the
toolbar if the polygon is not already assigned that material. (See Section 5.10, "Assigning Materials
After Drawing Polygons" for more information about selecting materials).
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Figure 8-9.  Select the polygon representing the frame and assign it the Wood (Pine, Spruce, Fir) material.

� Select the polygons representing the interior and exterior stop (you can select both of them by
holding the Shift key down and clicking the left mouse button on each polygon), and select
Wood (Cedar or Redwood) from the Materials list, as shown in Figure 8-10.

Figure 8-10.  Select multiple polygons by holding the Shift key down while clicking on multiple polygons.

8.3.1.4.  Save Your Work

� Save your work using the File/Save menu choice or the Save toolbar button . Remember to
save your files often, because there is no autosave feature in THERM.
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8.3.2.  Tracing a DXF Underlay

If you don’t want to use the DXF autoconvert feature, you can create the cross section polygons by tracing the
underlay. This may be necessary for some DXF files that have not been created in a way that autoconvert can
define the polygons properly.

� From the File menu, select the Underlay menu choice.

Figure 8-11.  To trace the DXF file, select the Underlay choice from the File menu.

� You will see the Underlay dialog box.

Figure 8-12.  The Underlay dialog box is used to select the DXF file to trace.

� Click on the Browse button.

� You will see a standard Windows™ Open dialog box, showing all files in your current working
directory with either a BMP or DXF file extension; you can change working directories and drives if
desired.  You should see at least the following sample file that was installed with THERM:

� SAMPLE.DXF
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Figure 8-13.  The Open dialog box shows all files with a DXF or BMP extension.

� Highlight SAMPLE.DXF by placing your mouse cursor over it and clicking the left mouse button.

� Click on the OK button, and you will return to the Underlay dialog box.

� Do not change any of the default values in the Underlay box; click on the OK button.

� You may see a small DXF Import dialog box, showing a counter as THERM reads the DXF file.

Figure 8-14.  A DXF Import file may appear if the file is complex and takes a few seconds to import.

� When THERM has finished reading the DXF file, it will display the underlay cross section in
gray, indicating that the lines are not true polygons but can be traced.
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Figure 8-15.  The DXF file has been imported as an underlay, which can now be traced to make the individual polygons.

� THERM attempts to fit the DXF cross section in the drawing area while still making the scale as big as
possible.   In Figure 8-15, you can see both the THERM origin (cross hairs corresponding to the origin
of the DXF file) and the cross section.

� Before you start tracing the underlay, you may need to zoom in on the cross section in order for the
cursor to snap to the correct underlay vertices. To zoom in, place your mouse cursor over the area of
the cross section that you want centered in the new zoomed view and click the right mouse button.
Each click of the right mouse button doubles the zoom percentage.

� You can use the horizontal and vertical scroll bars on the drawing area to move the underlay to the
desired location in the drawing area.  You only need to see the frame area of the cross section, not the
glazing system.

8.3.2.1.  Draw the Cross-Section Components

� Click on the Draw Polygon toolbar button or use the Draw/Polygon menu choice to begin
drawing.

� Click on the Repeat Mode toolbar button or use the Draw/Repeat Mode menu choice, so you
don’t have to press the Draw Polygon button each time you finish one polygon and start to draw the
next.

Draw Polygon

Repeat Mode

Figure 8-16.  Push the Draw Polygon and Repeat Mode toolbar buttons.
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� Start with the exterior stop on the outside of the glazing system.  Because you are in Draw Polygon
mode, the Materials pull-down list on the right side of the toolbar is active, and you can select the
Wood (Cedar or Redwood) material for the exterior stop. (Alternatively, you could access the
Libraries menu, select the Material Library or use the Shift-F4 keyboard shortcut, and pick Wood
(Cedar or Redwood) from the materials pull-down list). The material you select will be used by
THERM when you start drawing the first polygon.

Figure 8-17.  Select the appropriate material from the Materials pull-down list (on the right side of the toolbar)
 for the first polygon to be drawn.

� With the material selected, you are ready to start drawing the polygon for the exterior stop.  Place the
drawing cursor on the upper point of the stop nearest the glass and click the left mouse button.  This
sets the starting point of the polygon, as shown in Figure 8-18.

� Move the mouse to the left and down to the next point on the polygon, click the left mouse button,
and a line will appear between the two points, shown in Figure 8-18.  Because you are tracing a DXF
file, THERM recognizes the vertices of the polygons;, therefore you don’t have to be exactly on a
point but only to be within “sticky” distance (defined as half of one side of the drawing cursor) of the
point.
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Step 1: Position the
cursor at the starting
point of the polygon
and click the left
mouse button to set
the point.

Step 2: Move the cursor
to the next point and click
the left mouse button. A
line will be drawn
between the two points.
THERM will snap to the
underlay vertices if the
cursor is within the sticky
distance of the point.

Drawing Cursor

Figure 8-18.  Start drawing the first polygon.

� Move the mouse to the next point in a counterclockwise direction (moving in a counterclockwise
direction is not required, but is recommended) and click the left mouse button when you have
reached the next point.  Continue around the component until you only have one more line to draw.
To draw the last line and close the polygon, you can either press C (to close) or move the mouse to
the first point and click the left mouse button. Either of these actions will cause THERM to complete
the polygon, as shown in Figure 8-19, and fill it in with the color corresponding to the material
definition (or to a shade of gray on monochrome monitors).

Figure 8-19.  The first polygon, representing the exterior stop, has been drawn.



8.  TUTORIAL

8-12 JUNE 1998 THERM 2.0

� By default, the Snap to Underlay setting is enabled, so the drawing cursor will snap to vertices on the
underlay.  If you find the cursor snapping to points you don’t want, zoom in on the drawing by
clicking the right mouse button.  Snap to Underlay will snap within the distance of half of one side of
the cursor, so you don’t have to be exactly on a point for the snap to occur.

� Next draw the frame in which the glazing sits using the same method above; after that, draw the
inside stop, as shown in Figure 8-20.

� If you find that a component you are tracing is too large (and therefore is out of the drawing area) or
too small (the cursor is snapping to the wrong points), you can use the Zoom feature to zoom in and
out even when you are in Draw Polygon mode. For example, if you are drawing a line that ends
outside the THERM drawing area, hold the Shift key down and click the right mouse button. This
will cause the drawing view to be zoomed out so that you can probably see the entire component you
are tracing. Then you can continue to draw the line. When you have finished that line, you may want
to zoom back in to get more detail by clicking the right mouse button.

8.3.2.2.  Assign Different Materials to Polygons

� The frame components of the cross section can each be assigned a different material. To assign a
different material to a polygon, highlight it by placing the mouse cursor inside the polygon and
clicking the left mouse button once. The vertices of the selected polygon will be displayed as squares.
Select, for example, Wood (Pine, Spruce, Fir) from the Materials pull-down list on the right-hand
side of the toolbar.

Figure 8-20.  The wood components have been defined.

� Now you have three polygons representing the three main components of the wood frame cross
section.

� Press both the Polygon and the Repeat Mode toolbar buttons to turn off the drawing mode, or use
the Draw menu and uncheck (by clicking on them with your left mouse button) Polygon and Repeat
Mode (they are “on” when there is a check mark to the left; this selection toggles on or off each time
you click on the menu choice).
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8.3.2.3.  Save the File

� Save your work using the Save File toolbar button or the File/Save menu choice.  Type a name
that is not already being used, such as Tutorial2 (a file named Sample.thm is included in the
installation, so pick a different name to avoid overwriting that file), and click on the OK button.
THERM will automatically add the THM extension, in this case creating the file name
TUTORIAL2.THM.

8.3.3.  Using a Dimensioned Drawing

This section explains how to use THERM to draw from a dimensioned drawing. You will learn how to:

� Start a drawing from scratch,

� Use the keyboard and mouse to navigate and draw,

� Use keyboard short cuts.

8.3.3.1.  The Dimensioned Drawing

� You will be drawing the frame section of the following dimensioned drawing, using a combination of
the keyboard and the mouse.

� Note: be sure you are in °F mode (IP) for this exercise.  If you are in °C (SI) units, set the units to °F using the
“switch units” button on the menu bar or select it from the Options menu.
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Figure 8-21.  Dimensioned drawing of cross section

8.3.3.2.  Keyboard Short cuts

The following keys will be used in this exercise:

� F2:  Turns Draw Polygon on and off

� Shift+F7:   Sets the origin

� Home:  Centers the cursor over the origin cross hair

� Space bar:  Snaps the drawing cursor to the nearest point, to ensure that the cursor is exactly
on the point. This can be used when the sticky distance, which also causes the cursor to snap
exactly on a point, doesn’t apply.

� Esc:  Cancels drawing mode (and other modes)

� Any Number:  Enters the step size for cursor/line movement
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8.3.3.3.  Positioning the Drawing

� With your mouse, you can use the horizontal and vertical scroll bars on the drawing area to position
the origin (represented by cross hairs) in the lower right corner of the drawing, so you can see the
entire drawing without scrolling. (This position is based on the assumption that you want to start the
drawing on the origin; if not, this step is not necessary.)

8.3.3.4.  Setting the Material

� Press the F2 key to enable the Draw Polygon mode. This causes the Materials pull-down list on the
right side of the toolbar to become active; you can use your mouse to select the Wood (Pine, Spruce,
Fir) material for the frame. (Alternatively, you can access the Material Library by pressing Shift-F4,
or pressing Alt-L to access the Libraries menu, then typing M to access the Material Library.  Use
your mouse to view the choices in the pull-down materials list, or type the first few letters of the
material and use the up and down arrow keys to scroll through the list. Press Enter or click your left
mouse button on the Close button to close the dialog box.)

�  This defines the material for all polygons you draw until you select another material.

8.3.3.5.  Drawing the Dimensioned Part

� The polygons representing the frame and the interior and exterior stops will be drawn using the
following procedure:

� Type in the line dimension,

� Move the dimension length using the arrow keys,

� Press Enter to draw the line.

� Press the Home key on your keyboard, which causes the drawing cursor to be positioned at the
drawing origin. If you are not in Draw Polygon mode, press Alt-D, P. Press Enter to establish the
current cursor position as the starting point for drawing the polygon.

� With the dimensioned drawing example in front of you, begin your drawing from the lower right
corner and move counterclockwise (the program does not require that you draw in a
counterclockwise direction, but this is recommended). The extension at the corner is 0.688” high, so
type 0.688 from the number row or numeric keypad (be sure Num Lock is “on”) of your computer
keyboard.

� Note:  Do not press Enter (or the OK button on the Step Size dialog box) to accept the step-size;- as soon as
you type the number, the step size is set, and you can immediately use the arrow keys to move the distance you
have selected.

Figure 8-22.  The Step Size dialog box appears any time you type a numeric value. You can click on the OK button to set the step size,
or just use the arrow keys while the dialog box is open to move the step size distance.
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� Press the up arrow key once. A line will be drawn between your starting point and the new cursor
location.

Figure 8-23.  To draw a line using the keyboard:  from the origin, type in the step size, move the up arrow key, and press Enter.

� Press Enter to draw the line and anchor the end point.

� The next line length the extension is 1.000”.  Type 1, and you will notice that, on the status bar at the
bottom of the screen, the x,y gives your position relative to the origin. The dx,dy shows change in x
and y, telling you where you are relative to the last point anchored; len tells you the actual length of
the line. If you move the arrow keys, dx, dy and len will reflect the values for the current dimension
being drawn.

� Press the left arrow key once, then press Enter to draw the line.

� The height of the next step is 0.500” (1.188 - 0.688). Type 0.5, press the up arrow key once, then press
Enter to draw the line

� For this example, we will initially simplify the drawing process by squaring off the beveled edge,
marked as .100 CHAMFER in Figure 8-21. This change will have very little effect on thermal
performance. If you would like to include the bevel in your model follow the steps in Section 8.3.3.8.

� The next horizontal length is 1.750” (2.75 - 1.00). Type 1.75, press the left arrow key once, then press
Enter to draw the line.

� If the interior stop had been made of the same material, we could have included it as part of this
polygon. It is up to you to decide how to combine cross section elements.  If there is any chance that
elements may be used with other drawings or may be moved, it is best to keep them separate. If two
polygons are made of different materials, they must be drawn separately.

� The next vertical length is 0.500”.  Type 0.5, press the down arrow key once, then press Enter to draw
the line.
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� The next horizontal length is 1.813 (seen at the bottom of the drawing).  Type 1.813, press the left
arrow key once, then Enter to draw the line.

� We’re now about half done with the example. Your drawing should look like this:

Figure 8-24.  Using the keyboard, you can type the polygon dimensions and use the arrow keys to draw the lines.

8.3.3.6.  Completing the Polygon

� The next vertical length is 0.688”.  Type 0.688, press the down arrow key once, then press Enter to
draw the line.

� The next horizontal length is 0.313”.  Type 0.313, press the right arrow key once, then press Enter to
draw the line.

� The next vertical length is 0.219”.  Type 0.219, press the up arrow key once, then press Enter to draw
the line.

� The next horizontal length is 0.250”.  Type 0.250, press the right arrow key once, then press Enter to
draw the line.

� The next vertical length is 0.219”.  Type 0.219, press the down arrow key once, then press Enter to
draw the line.

� The next horizontal length is 1.64” (2.203 – 0.313 – 0.250).  Type 1.64, press the right arrow key once,
then press Enter to draw the line. Another technique, which lets the program do the arithmetic for
you, would be to type 2.203, press the right arrow key once, type 0.313, press the left arrow key once,
type 0.250, press the left arrow key once, then press Enter to draw the line and anchor the end point.

� The next vertical length is 0.219”.  Type 0.219, press the up arrow key once, then press Enter to draw
the line.

� The next horizontal length is 0.125”.  Type 0.125, press the right arrow key once, then press Enter to
draw the line.
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� The next vertical length is 0.219”.  Type 0.219, press the down arrow key once, then press Enter to
draw the line.

� Press C to close the polygon, and the program will automatically draw a line between the current
cursor location and the starting point of the polygon.

� When you are finished and the polygon is filled in, press the Esc key to cancel the polygon mode.

� Your finished polygon should look like the picture in Figure 8-25.

Figure 8-25.  The completed polygon that represents the frame

8.3.3.7.  Correcting Mistakes While Drawing

If you make mistakes while drawing a polygon, there are several ways to make corrections without
deleting the entire polygon. Here are a few techniques:

� Wrong Dimension:  If you accidentally enter the wrong dimension and move the cursor using the
arrow keys, simply use the arrow keys to backtrack to the last point drawn (len = 0.000).
Alternatively, you can use the mouse to position the cursor over the last good point and press the
Space bar, which causes the cursor to snap exactly to that point.  Then type in the correct
dimension and start over (you can also use the technique below to move back).

� Accidental Mouse Movement:  Movement of the mouse while drawing a polygon may cause the
line to shift, changing the dimensions.  If you accidentally move the cursor, use the mouse to
position the cursor over the last good point and press the Space bar, which causes the cursor to
snap exactly to that point. Be sure len = 0.000 before you begin drawing again.

� Wrong Point:  If you’ve entered the wrong dimension (as in the first technique above) but pressed
the Enter key to anchor the point, you may delete the point by pressing the Esc key once.  Use the
mouse to reposition the cursor as in the technique above.  Pressing the Esc key twice produces
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the following dialog box shown in Figure 8-26 for deleting additional points or the entire
polygon.

Figure 8-26.  This dialog box allows you to delete the last point in a polygon.
You can use your mouse or the arrow keys to move to each button in the box.

8.3.3.8.  Drawing Additional Polygons

Interior Stop:

� Place the mouse cursor over the corner of the frame where the lower left corner of the interior
stop will be located. Press F3 or Alt-D,R to activate the Draw Rectangle toolbar button. Place the
cursor within the sticky distance (half of one side of the cursor cross hair) and press Enter to set
that location as the starting point for the rectangle. Now you are ready to draw the rectangle
representing the interior stop.

� Type the horizontal dimension of the rectangle, 1.094, and press the right arrow key once to draw
the first side of the rectangle. (Do not press Enter yet !)

� Type the vertical dimension of the rectangle, 0.50, press the up arrow key once, then press Enter,
and the program will draw the rectangle, assigning it the last used Material, which should be
Wood (Pine, Fir, Spruce).

� You can add the bevel on the stop using the mouse and the keyboard as follows:

� Highlight the interior stop polygon by placing your mouse cursor inside the polygon and
clicking the left mouse button once. The vertices of the highlighted polygon will be indicated
by squares.

� You may want to zoom in on the drawing by clicking the right mouse button once or twice in
order to see more detail.

� Type 0.100 and press Enter (or click the OK button) to set the step size to 0.100".

� Click on the Insert Points toolbar button and place the mouse cursor over the upper
right corner. Press Space bar to locate the cursor exactly on that corner point, press the left
arrow key once to move the cursor 0.100" to the left, and press Enter to insert the new point.

� Click on the Edit Points toolbar button and place the mouse cursor over the same upper
right corner point as in the previous step, so we can move the point. Press the Space bar to
locate the cursor exactly on the point to be moved. A double-pointed arrow should appear,
which indicates that you can move the point. If a four-pointed arrow appears, this indicates
that you are on a line rather than a point, which means that the cursor was outside the sticky
distance of the point. (If you press the down arrow under this condition, the entire line will
move. You will need to zoom in so that you can position the cursor on the point you wish to
select).

� Press the down arrow key once, which will move the point down 0.100".

� Press Enter to set the point in the new location. The lines attached to the point will be
redrawn at the new angle.
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Exterior Stop:

� We will draw the polygon for the exterior stop in a similar fashion. The drawing in Figure 8-
27 contains the dimensions needed to draw this polygon. We will first draw a rectangle, and
then insert and move points to make the beveled sides of the polygon.

0.137

0.425

0.438

0.059

0.655

0.137

Starting point
for drawing
exterior stop

Figure 8-27.  Dimensions for the exterior stop.

� We will use the lower left corner of the stop as the starting point for the rectangle. To locate
the drawing cursor at this corner point, first place the cursor on the left corner of the frame
polygon closest to the point. Press the Space bar to locate the cursor exactly on the point. The
lower left corner of the exterior stop is 0.059" to the right of this point, so type 0.059 and press
the right arrow key once. The location of the cursor will be the starting point of the stop.

� Press F3 to activate the Draw Rectangle mode. Press Enter to set the current cursor position
as the starting point for the rectangle.

� The exterior stop is 0.655" wide, so type 0.655, and press the right arrow once.  This
establishes the width dimension of the rectangle. Do not press Enter yet !

� The exterior stop is 1.00" high, so type 1, press the up arrow once, and press Enter. You now
have a rectangle 0.655" by 1.00".

� Next, we are going to insert a point on the left side of the stop where the bevel starts.
Highlight the exterior stop by placing the drawing cursor  inside the rectangle and clicking
the left mouse button once. The vertices of the highlighted rectangle will be displayed as
squares.

� Click your mouse on the Insert Points toolbar button , and place your mouse cursor over
the lower left point (the starting point) of the exterior stop. Press the Space bar to position the
cursor exactly on the point. The point on the left side of the stop where the bevel starts is
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0.438" above the starting point, so type 0.438 and press the up arrow key once. Press Enter,
and a point will be inserted at your cursor position.

� Click your mouse on the Edit Points toolbar button , and place the mouse cursor over
the upper left point on the exterior stop. When you are over the point, the cursor will turn
into a double-pointed arrow. Press the Space bar to place the cursor exactly on the point.

� The bevel is 0.137" off the horizontal and vertical lines, so type 0.137, and press the right
arrow key once, then the down arrow key once. Press Enter, and the point will be redrawn in
the proper position, with the attached lines following and forming the beveled edge.

� You have now finished drawing all the frame and stop elements and can proceed to the next
part of the tutorial:  inserting the glazing system.

Step 1: Draw a
rectangle to
represent the
exterior stop.

Step 2: Press
the Insert Point
toolbar button,
position the
cursor on the
lower left corner
of the stop,
press the
Spacebar, type
0.438, press the
up arrow key
once, and press
Enter. A point
will be inserted.

Step 3: Click on the Edit Point
toolbar button, place the cursor
over the upper left corner of
the rectangle, press Spacebar,
and type 0.137. Press the right
arrow key once and the up
arrow key once. Press Enter
and the point will be moved
and the polygon redrawn with
the bevel.

Figure 8-28.  Adding the beveled edge to the exterior stop

8.3.3.9.  Save the File

� Save your work using the Save File toolbar button , or the File/Save menu choice.  Type a name
that is not already being used, such as Tutorial3 (a file named Sample.thm is included in the
installation, so pick a different name to avoid overwriting that file), and click on the OK button.
THERM will automatically add the THM extension, resulting in this case in creating a file name of
TUTORIAL3.THM.

8.4.  Import a Glazing System from WINDOW 4
Now that you have drawn the frame and stop components of the cross section, you are ready to import a
glazing system from the WINDOW program. A sample WINDOW glazing system library is provided with
the THERM installation.
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� From the Draw menu, click your left mouse button on the Locator choice.

Figure 8-29.  Select the Locator choice from the Draw menu.

� Move the mouse cursor to the lower left corner where the glazing system is to be inserted, and
click on the left mouse button.  A small circle will appear indicating the position of the Locator, as
shown in Figure 8-30. (If you are not using an underlay, first draw the glazing tape to the right of
the exterior stop, to serve as a guide for placing the Locator.)

Position Locator:
Place the drawing cursor in the lower left corner of the location
where the glazing system will be inserted, and click the left
mouse button. A small circle will appear.

Figure 8-30.  Position the locator where you want the lower left corner of the glazing system to be placed.

� From the Libraries menu, select the Glazing Systems choice.
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Figure 8-31.  Select the Glazing Systems choice from the Libraries menu.

� The Glazing Systems dialog box will appear with a pull-down list showing all the choices from
the WINDOW “GLZSYS.W4” file that was installed with THERM.  You can use the Browse
button to locate other GLZSYS.W4 files if desired. However, for this example, you should use the
library that is provided with THERM.

Figure 8-32.  The Glazing Systems dialog box displays the information about each glazing system choice.

� Put the mouse cursor on the pull-down list arrow, click the left mouse button, and the list of
glazing systems will be displayed.  Scroll through the list (using your mouse or arrow keys) and
pick the “THERM SAMPLE” choice.

Figure 8-33.  Select the THERM SAMPLE glazing system to be inserted in the tutorial example.

� Press the Import button, and the Insert Glazing System dialog box will appear.  Leave all the
default values as they are, and press the OK button. (The Draw Spacer box is left unchecked because
we will insert a custom spacer later in the tutorial).
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Figure 8-34.  The Insert Glazing System dialog box appears when you are importing a glazing system from WINDOW.

� The glazing system will be inserted into the frame with the lower left corner positioned where the
Locator was placed.

Figure 8-35.  The glazing system from WINDOW has been inserted into the frame components.

� Now that the glazing system has been inserted, glazing tape can be drawn between the glazing
system and the interior and exterior stops (if you haven’t already completed this step), as follows:

� Click the right mouse button as many times as you need in order to enlarge the drawing so
that you can snap to the points described below.  You may have to enlarge it quite a bit.

� Press the Draw Rectangle toolbar button .

� Select Polysiobutylene from the materials pull-down list on the right-hand side of the
toolbar.

� Position the drawing cursor in the upper left corner of the space to the left of the glazing
system, and click the left mouse button. Keeping the left mouse button down, move the
drawing cursor down to the lower right corner of the gap; release the mouse button. A
rectangle will be drawn that exactly fits in the space.
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Step 1: Select the
material for the glazing
sealant.

Step 2: Position
the drawing
cursor in the
upper left corner
of the space.
Click the left
mouse button
and hold it down.

Step 3: Keeping the left mouse
button down, move the drawing
cursor to the lower right corner of
the space, and release the
mouse button. A rectangle will be
drawn that fills the space.

Figure 8-36.  Draw a rectangle that fills the space between the exterior stop and the glazing system.

� In the same manner, draw a rectangle for the glazing tape between the interior stop and the
glazing system.

Draw a rectangle to represent
the glazing tape between the
glazing system and the interior
stop.

Figure 8-37.  Draw a rectangle that fills the space between the interior stop and the glazing system.

� The lower right corner of the exterior stop does not lie exactly on the frame, and because it is
necessary to either fill or delete all voids, we have to decide what to do with this area. One
solution is to move that corner down to the frame, as follows:

� Highlight the exterior stop by placing the mouse cursor inside the polygon and clicking the
left mouse button once. The vertices of the selected polygon will be displayed as squares.
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� Click the left mouse button on the Edit Point toolbar button .

� You may want to zoom in (click the right mouse button) one or two times to enlarge the cross
section. Position the mouse cursor over the lower right-hand corner of the exterior stop. The
cursor will be displayed as a double-pointed arrow, which means you can move the point.

� Hold down the Shift key to restrain the cursor movement to the vertical direction. Then,
holding the left mouse button down, move the mouse (and the point will follow) down to the
frame. Release the mouse button.

Step 1: Click on the
Edit Point toolbar
button

Step 2: Place the mouse cursor
over the point to be moved. The
cursor will change to a double-
headed arrow when it is over the
point.

Step 3: Holding the left mouse button down, move the
mouse cursor to the new location of the point, in this
case down to the frame.

Figure 8-38.  With the Edit Point toolbar button activated, place the mouse cursor over the point to be moved,
hold the left mouse button down, and move the mouse to the new point location.

� The point and attached lines are moved, and the polygon is redrawn, as shown in Figure 8-
39.
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The point and all attached
lines are moved and the
polygon is redrawn with the
new shape.

Figure 8-39.  THERM will move the point and the lines attached to that point and redraw the cross section with the new geometry.

� Another option for this space would be to define it as a cavity. In that case, you should make this sliver a
separate cavity polygon from the main cavity area. The effective conductivity of the cavity is based on the
overall dimensions of a cavity and if you include the sliver you effectively double the size of the main
cavity.  The first solution, to bring the exterior stop corner down to the frame and model that area as
wood, is a better thermal approximation than modeling the whole area as one cavity.

� You can copy and paste into the cross section a spacer  from another THERM file, as follows:

� Use the File menu, Open option to open SPACER.THM, another sample file that was
installed with the THERM program. This file contains a cross section of a custom spacer that
we can copy and paste into our tutorial cross section.
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Figure 8-40.  Use the Draw/Locator menu choice to position the Locator in the upper left corner of the spacer.

� Use the Draw/Locator menu to place the locator circle in the upper left corner of the spacer
drawing (if it is not already there), as shown in Figure 8-41.

Select Locator from the Draw menu, place the cursor
in the upper left corner of the spacer, and click the left
mouse button. The Locator circle will appear.

Figure 8-41.  Position the Locator in the upper left corner of the spacer.

� Use the Edit/Select All menu to select all the polygons in the spacer file. Or you can click on
a point above and to the left of the spacer, and holding the left mouse key down, move the
cursor to a point below and to the right of the spacer. A dashed box will be displayed
showing the area you have moved your cursor, and all the polygons inside that area will be
automatically selected.
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� Use the Edit/Copy menu, or Ctrl-C, to copy the selected polygons to the Windows™
clipboard.

Figure 8-42.  Use the Edit/Select All menu choice to select all the polygons in the spacer;
 then, use Edit/Copy (or Ctrl-C) to copy these polygons into memory.

� Use the Window menu to select the tutorial cross section file.

� Use the Draw/Locator menu to place the locator circle in the upper left corner of the recess
under the glazing system cavity where you want the upper left corner of the spacer to be
located.

� Use the Draw/Paste menu, or Ctrl-V, to paste the spacer into the SAMPLE cross section. The
spacer will be placed in the cross section by matching up the positions of the two Locators.

Locator positions for the
cross section and the
spacer are matched up
when the spacer is pasted
into the cross section.

Figure 8-43.  Use the Edit/Paste menu choice to paste the spacer into the cross section.



8.  TUTORIAL

8-30 JUNE 1998 THERM 2.0

� Select the Libraries menu, Material Library choice (or press Shift-F4), and select the Frame Cavity
NFRC Simplified material from the Materials list.

� Select the Fill tool and click in the area between the glass and the stop. This area will automatically be
filled by the program with a polygon of the material Frame Cavity NFRC Simplified.

Figure 8-44.  Use the Fill tool to fill in the cavities in the cross section.

� When you have finished these polygons, Zoom the drawing back out, either holding down the
Shift key while clicking the right mouse button repeatedly until the drawing is the size you want
it to be, or Ctrl right mouse click to zoom to fit the drawing in the screen.
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Figure 8-45.  The finished cross section.

8.5.  Define Boundary Conditions
� Next, you need to define the boundary conditions for the cross section.

� Press the Boundary Conditions toolbar button , or use the Draw/Boundary Conditions
menu choice.

� If the program detects any flaws in the drawing while assigning the boundary conditions, a
message will appear, and you may have to fix the problems before the program can continue
defining the boundary conditions.  See Section 6.3, "Error Detection in THERM" for detailed
discussions of this situation.

� THERM will automatically draw an exterior boundary around all the cross-section components,
indicated by a heavy line.  The boundary condition is actually made up of many boundary
segments, which can each be given different boundary condition definitions.
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Figure 8-46.  When you press the Boundary Conditions toolbar button,
THERM draws an exterior boundary around all the cross-section components.

� The default boundary condition for all the boundary elements except the glazing system is adiabatic.
The glazing system is automatically given THERM SAMPLE U-factor Inside and THERM SAMPLE
U-factor Outside boundary conditions (the program automatically adds the glazing system name, in
this case THERM SAMPLE, as a prefix to the boundary condition name) if the glazing system was
inserted from a WINDOW glazing system.

� Select the lower right boundary segment on the interior frame (the right side) by moving the mouse
cursor to it and pressing the left mouse button.  Round points on each end of the segment indicate
that it has been selected.

� Hold the Shift key down, and click on the segment on the interior stop. The program automatically
selects all boundary segments between the first and last selected segments, moving in a
counterclockwise direction, as shown in Figure 8-47.

� Press Enter and the Boundary Condition Type dialog box will appear.  Select Interior Wood/Vinyl
Frame for the boundary condition and Frame for the U-Factor Surface as shown in Figure 8-47.  Press
the OK button.
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Step 1: Click the left
mouse button on the
first boundary
segment.

Step 2: Hold the Shift key down, and
double click on the last boundary segment,
moving in a counterclockwise direction.

Step 3: The Boundary Condition
Type dialog box will open, and you
can select the appropriate
Boundary Condition and U-factor
Surface.

Figure 8-47.  Select multiple boundary segments for the interior side of the cross section, and define their boundary conditions.

� Use the same technique to define the boundary conditions for the exterior (left side) of the cross
section, as shown in Figure 8-48. Select the exterior boundary segments for the exterior stop and
the frame, and assign them the Boundary Condition of Exterior Surface.

Step 1: Click the left mouse
button on the first boundary
segment.

Step 2: Hold the Shift key
down, and click on the last
boundary segment, moving in a
counterclockwise direction;
then, press Enter.

Step 3: The Boundary Condition Type dialog box will
open, and you can select the Exterior Surface
boundary condition.

Figure 8-48.  Select multiple boundary segments for the exterior side of the cross section, and define their boundary conditions.
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� To view the boundary conditions automatically defined for the imported WINDOW glazing
system, place the mouse cursor on the inside boundary segment of the glazing system, and
double-click the left mouse cursor.  The Boundary Condition Type dialog box will appear.
THERM SAMPLE: Inside U-factor will already be selected for the Boundary Condition, and
Edge for the U-Factor Surface, as shown in Figure 8-49.  Press the OK button.

Figure 8-49.  You can view the boundary condition definitions for the glazing system by double-clicking the left mouse button on the
glazing system boundary.

� Save the file using the Save File toolbar button , or the File/Save menu choice.

8.6.  Run and View the Results

� Press the Calculation toolbar button , or select the Calculation/Calculation menu choice.

� The status bar at the bottom of the THERM screen will display the steps of the calculation, as shown
in Figure 8-50.
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As the calculation
proceeds, the status bar
will display the steps.

To begin the calculation,
click on the Calculation
toolbar button.

Figure 8-50.  Click on the Calculation toolbar button; as the calculation proceeds, the steps will be displayed on the status bar.

� When the simulation is finished, the default isotherm results will be drawn on the cross section, as
shown in Figure 8-51.

Figure 8-51.  When the calculation has finished, the program will display the results as isotherms.
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� You can view the U-factor results using the Calculation/Show U-Factors menu choice.

Figure 8-52.  U-Factor results, accessed from Calculation/Show U-Factors menu choice.

� You can view other results in other formats using the Calculation/Display Options menu choice,
which opens the Results Display Options dialog box. For more detailed information about the types
of results available from THERM, see Chapter 7, "Results."

Figure 8-53.  Other results can be displayed by changing the values in the Results Display Options dialog box, access from the
Calculation menu, Display Options choice.


